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Segmentacion

- Partir la imagen en grupos de pixeles diferentes segun algun criterio.
* Similitud — regiones que comparten propiedades.
- Diferencia = fronteras entre las regiones.

* Es un problema dual: las regiones tienen fronteras y las fronteras
separan regiones.



Binarizar

* Histograma de la imagen y exploracidon: en la imagen de ejemplo
leaf.jpg

* Analyze — histogram

- Explorar, con log y sin log y por canales RGB
- ¢ES mono, bi, trimodal?

- ;Tienen componentes en qué rangos?

- Descomponer la imagen en tres o convertirla a grises.
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Press "I" (Image=Show Info) for information



Segmentacion

* En general trabajaremos en niveles de gris.
- Convertir la imagen
- Dividir en 3 imagenes, una por cada color.

* Image - Color = Split Channels

* Ver el histograma de cada canal



Canales rojo, verde y azul
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[ N ] Histogram of embryos
300x240 pixels; RGB; 281K
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Count: 1920000 Min: 8
Mean: 185.286 Max: 246
StdDew: 19.047 Mode: 189 (18BET7)

List Copy Log Live ggz

269 embryas.jog (green) (33.3%)

1600x1200 pixels; 8-bit; 1.8MB
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[ N N ) Histogram of embryos
300x240 pixels; RGB; 281K
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Count: 1920000 Min: O
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StdDew: 22.198 Mode: 168 (187354
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List Copy Log Live 415

269 ambryes.jpg (blue) (33.3%)
1600x 1200 pixels; 8-bit; 1.8MB

®9® Histogram of embryos
300x240 pixels; RGB; 281K
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: : 92
List Copy Log Live 1p575d



Umbralizar (Binarizar)

* Definir un umbral y dar a la
imagen un valor si esta por
arriba y otro por debajo del
umbral.

* Image - Adjust - Threshold

® ® @ blobs.gif
256x254 pixels; 8-bit (inverting LUT); 64|
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Default: 125
Huang: 120
Intermodes: 129
IsoData: 125

Li: 106
MaxEntropy: 112
Mean: 103
MinError(l): 80
Minimum: 124

Moments: 128
Otsu: 127
Percentile: 56
RenyiEntropy: 100
Shanbhag: 168
Triangle: 50

Yenm: 88

1032x1088 pixels; 8-bit (inverting LUT); 1.1MB

ontage (75%)




Umbralizar (Binarizar)
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Umbralizar (Binarizar) ﬂ |E
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Umbralizar (Binarizar)
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parasitos

88 parasitos.png
E?2x512 pixels; 16-bit; 672K

88 carasitos.png
E?2x512 pixels; 16-bit; 672K

@ Threshald
5 27 %
15420
65535
Default Red <
J Dark background Stack histogram
Auto Apply Reset Set

@& Threshold
6.73 %
8224
65535
Minimum [T Red [T |
w4 Dark background Stack histogram
Auto Apply Reset Set
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Ya podemos hacer algunas cosas... 1S,

Umbral, método minimum, Dark Background, B&W.

Analyze —» Set Measurements y seleccionar

Analyze — Analyze Particles...

Analyze -» Summarize

@ Analyze Particles

Size (pixelA2): O-Infinity

® @& parasiios.png 00 ROI Manager " .
672x512 pixels: 8-hit (inverting LUT); 336K 0001-0021 Add 1] Circularity: 0.00-1.00
v - v 0002-0010 )
0003-0004 Update . -
0004-0012 | Show: NOthmg | v
& 0005-0007 Delete
0006-0069 Rename...
0007-0043 Exclude on edges
0008-0069 Measure
0009-0107 .4 Clear results Include holes
0010-0169 Deselect
0011-0170 Properties Summarize Record starts
0012-0196 y
0013-0205 Flatten [F] ./ Add to Manager In situ Show
A4 0014-0204
q 0015-0210 More »
; 0016-0215 Hel Cancel OK
w W o 0017-0218 Show All P
0018-0236
e
y 209 Results
|Label |Area  [Mean [StdDev [Min |Max |XM |YM |
@ B parasitos.png 2096 255 0 255 255 386.135 19.619

255 255 525.217 8.930
255 255 586.826 3.243
255 255 B50.313 11.033
255 255 331.821 7.393
255 255 410.939 68.717

parasitos.png 674  255%
parasitos.png 144 255
parasitos.png 833 255
parasitos.png 28 255
parasitos.png 2203 255

o o= on w1 B W R

i I i - i D i i O i R i o i i

o parasitos.png 18 255 255 255 525.000 43.111
- parasitos.png 26 255 255 255 362.231 69.192
g parasitos.png 1774 255 255 255 304.326 106.968
a & 10  parasitos.png 2091 255 255 255 607.179 169.343
11 parasitos.png 26 255 255 255 270.808 170.038
[=F] 13 naracitne Ann 1718 IER 14 IEE IET TRA 1G4 BE18




Overlay

* Tengo la imagen original.

* Tengo la mascara creada por la binarizacion, que salvo
con un nombre.

- Eventualmente: Edit = Invert

* Las superpongo, debo tener ambas imagenes abiertas:
* Image - Overlay - Add Image

& Add Image...

Image to add: | parasitos-1.png |+

- Marcar Zero Transparent, seleccionar la imagen vy fijar .
eI Origen. Opacity (0-100%): 100
¥ Zero transparent
* Flatten, crea una imagen nueva con la original y la Cancel K
mascara superpuesta. —
672x512 pixels; 16-bit; 672K : - 672x512 pixels; 8-bit (inverting LUT); 336K : A‘ : . ' - - 672x512 pixels; 8-bit; 336K : : U ‘ - -
& o @ % o ®
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Usando el ROl Manager

[ J
Abrir parasitos.png
[}
Duplicarla
[ J
Umbralizar eligiendo el umbral (seleccionar Dark Background)
L] [ ]
Usar Analyze Particles con las siguientes elecciones:
o0 ) . ) parasitos-1.png @ Analyze Particles
672x512 pixels; 8-bit (inverting LUT); 336K .
0 ‘ - - » ROI Manager
. 00150274 Add [1] Size (pixelA2): O-Infinity
a 0016-0300 . .
0017-0334 Update Clrcu!arlty: 0.00-1.00
[y 0018-0304 Delete
0019-0308 ; i
0020-0342 Rename... Shcw NOthlng M
0021-0356 Measure
0022-0393 < :
0023-0426 Deselect . Display results ' Exclude on edges
0024-0407
. 0025-0410 Properties. .. 4 Clear results Include holes
0026-0411 Summarize Record starts
q 0027-0414 Flatten [F] =
0028-0428 Mare » 4 Add to Manager In situ Show
0029-0434
0030-0459 Show All
0031-0472 Hel Cancel OK
p 0032-0504 Labels P
[15]
a 2 ® 8 Results
|Label |Area  |Mean [StdDev [Min [Max [XM [YM |
N 1 parasitos-1l.png 28 255 0 255 255 331.821 7.393
2 parasitos-1l.png 2203 255 0 255 255 410.939 B8.717
- 3 parasitos-1l.png 18 255 0 255 255 525,000 43.111
‘ 4 parasitos-1.png 26 255 0 255 255 362.231 ©9.192
& & 5 parasitos-1.png 1774 255 0 255 255 304.326 106968
) b parasitos-1l.png 2091 255 0 255 255 B07.179 169.343
7 parasitos-1l.png 26 255 0 255 255 270.808 170.038
0 8 parasitos-1.png 1718 255 0 255 255 257366 194519
9 parasitos-1l.png 1838 255 0 255 255 409.338 205.192
&H 10 parasitos-l.png 32 255 0 255 255 B21.094 204.406
11 parasitos-1l.png 20 255 0 255 255 225400 210.500
12 maracitne_1 mnm 18 JER f L S 4 161 MER 218 &11



Usando el ROl Manager

Seleccionar parasitos.png

Incorporar a parasitos.png las regiones determinadas anteriormente
desde el ROl Manager mediante Image > Overlay > From ROI
Manager

Seleccionar en el ROl Manager todas las regiones

Presionar el botdn Measure

* Las medidas a realizar se seleccionan en Analyze > Set Measurements y
se despliegan en la ventana Results.

2@ 0

oarasitcs.png

® ® @ Results

|Label |Area  |Mean |StdDev Min  [Max |X
22 parasitos.png:0022-0393 17 10599.000 1725.873 8404 14091 6
23  parasitos.png:0023-0426 1959 15580.128 4563.928 7189 30547 5
24 parasitos.png:0024-0407 3 8734.000  738.547 8276 9580 5
25 parasitos.png:0025-0410 14 16209.143 5606.574 8276 25978 1
26 parasitos.png:0026-0411 8 10628.375 1218B.852 9330 12557 5
27  parasitos.png:0027-0414 13 11068.000 1655.570 691 13516 4
28 parasitos.png:0028-0428 17 13863.706 5010.710 8276 23294 §
29 parasitos.png:0029-0434 16 13088.688 2467.959 8308 18565 1
30 parasitos.png:0030-0459 2075 14976.321 4653.358 7733 33648 1
31 parasitos.png:0031-0472 14 14862.571 4404.543 8404 22878 1
32 parasitos.png:0032-0504 15 10333.600 1430.494 8308 12941 8

672x512 pixels; 16-bit; 672K




Morfologia matematica: erosion

* Binarizar: Process — Binary —» Convert to Mask
* Elemento Estructurante (ES): por ejemplo, un disco de radio r

+ Erosion: saca pixeles del borde (1 si ES esta incluido en el objeto):
* Process - Binary - Erode

N N parasitos.png 209
672x512 pixels; 8-bit {inverting LUT); 336K 672x512 pixels; 8-bit (inverting LUT); 336K
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Morfologia matematica: dilatacion

- Dilatacién: agrega pixeles al borde (1 si ES intersecta al objeto):
* Process — Binary — Dilate




Morfologia matematica: apertura

- Apertura: dilatacién de la erosion (Process — Binary — Open).
* Suaviza el borde. Elimina islas y peninsulas.
- Erosiona y dilata

ORORC)
672x512 pixels; &-bit {inverting LUT); 336K

(ONORC)
672x512 pixels; 8-bit {inverting LUT); 336K




Morfologia matematica: cerradura

- Cerradura: erosion de la dilatacion (Process — Binary — Close).
* Suaviza el borde. Elimina huecos y bahias.
* Dilata y erosiona.

672x512 pixels; 8-bit {inverting LUT); 336K 672x512 pixels; 8-bit (inverting LUT); 336K
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Morfologia matematica: outline

* Bordes: los bordes por sustraccion de dilatado - erodado
* Process — Binary — Outline




Morfologia: Watershed

* Sobre la imagen binarizada.

- Método morfoldgico para separar particulas.
* Process - Binary - Fill Holes
* Process - Binary —» Watershed

* Calcula el mapa de distancia euclidiana (EDM)
* Busca los maximos del EDM que son los Ultimate Eroded Points (UEP)

- Dilata los UEP hasta que tocan los bordes de la particula o de otro
UEP en crecimiento.



Morfologia matematica: hay mucho mas... e <3 IE

- Esqueleto (puntos que tienen al menos dos puntos en la frontera a la
misma distancia)

* Process —» Binary — Skeletonize

- Mapa de distancia euclidiana (funcion distancia de cada pixel al
borde)

* Process — Binary — Distance Map

+ Ultimate points (erosiona hasta que queda un ultimo punto)
* Process — Binary — Ultimate Points

e8P parsgitne-2nrg 'Y L paracitae-1 prg e8P parasites pog
672%512 pixels; 8-hit (inverting LUT), 336K 672x512 pixels; 8-bit (inverting LUT); 336K 672512 pixels; 8-bit (inverting LUT); 336K
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;Reqgularidad, irreqularidad, fronteras?

* Regiones uniformes vs. frontera entre regiones.
- Las regiones uniformes vs. el ruido...

* Ruido y bordes tienen naturaleza similar (cambios bruscos, alta
frecuencia): caracter dual de “sacar ruido” y “detectar bordes”

* Filtrado isotrépico pasa bajo (promedio): Process — Filter » Mean vy
fijar parametro.

- Filtrado isotrépico pasa bajo (mediana): Process - Filter » Median y
fijar parametro.



Filtrado promedio vs mediana

Original Filtro promedio (r=2)
@®® blobs.gif

256x254 plxels 8-bit (inverting LUT); 64| 256x254 pixels; 8-bit (inverting LUT); 64|

Filtro mediana (r=2)

256x254 pixels; 8-bit (inverting LUT); 64|

Filtro promedio (r=4)

256x254 pixels; 8-bit (inverting LUT); 64|

Filtro mediana (r=4)

256x254 pixels; 8-bit (inverting LUT); 64|
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Filtro promedio (r=10)

256x254 pixels; 8-bit (inverting LUT); 64|
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Difusidon anisotrdpica

- Filtrado anisotropico pasa bajo: Plugins — Process — Anisotropic
Diffusion

* Preserva bordes.

® e @® myelin.png © O © myelin-iter20
256x256 pixels; 8-bit; 64K 256x256 pixels; 8-bit; 64K




Bordes

* Un borde definido como el limite entre dos regiones con propiedades
diferentes.

* A veces se puede modelar como una discontinuidad en el nivel de
gris (en este caso la propiedad de cada regién esta representada por
el nivel de gris).

- La derivada local da cuenta de estas variaciones.

Perfil

r] 1lra. derivada r]

[

ll 2da. derivada l l




* Operador que aproxima el
gradiente (primera derivada)

- Separable: una mascara da la
componente X y otra la
componente Y del gradiente.

- Se puede ver el modulo del
gradiente en cada pixel




Sobel en Image]

* Process — Find Edges
+ Esto entrega en cada pixel el valor del gradiente
 Se visualiza el médulo del gradiente

- También puede ser util ver la direccion del gradiente (perpendicular
al borde en el punto)
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Bordes




Umbral sobre el médulo del gradiente

* Problema de un umbral global:

- Arriba: salida mddulo del gradiente
* 1zg.: 10% de los puntos con gradiente mayor.
* Ce.: 2% de los puntos con gradiente mayor

* Der.: 1% de los puntos con gradiente mayor.



Bordes: NMS

- El mddulo del gradiente debe ser un maximo local en el sentido
perpendicular al borde.... y estar conectado con otro pixel que sea
maximo local en el mismo sentido.

* Se utilizan dos umbrales con histéresis sobre el mdédulo del gradiente:

- Marco los puntos tengan un mddulo del gradiente mayor al umbral
altoy

* Los que tengan un médulo del gradiente mayor al umbral bajo y
estén conectados a otro ya marcado.

* Luego de haber aplicado un detector de mdédulo de gradiente (Sobel
por ejemplo):

* Plugins = Image Edge —» Conn Threshold



Sobel + NMS
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Difusion isotropica

® @® @ lena-std.tif
512x512 pixels; 8-bit; 256K




Difusion isotropica

® @® @ lena-std.tif
512x512 pixels; 8-bit; 256K




Difusion isotropica

® @® @ lena-std.tif




Difusidon anisotrdpica

. . . lena-std-iter100
1/6 (orig); 512x512 pixels; 8-bit; 1.5MB
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Difusidon anisotrdpica

. . . lena-std-iter100
2/6 (iter20); 512x512 pixels; 8-bit; 1.5MB




Difusidon anisotrdpica

. . . lena-std-iter100
3/6 (iter40); 512x512 pixels; 8-bit; 1.5MB




Difusidon anisotrdpica

. . . lena-std-iter100
4/6 (iter60); 512x512 pixels; 8-bit; 1.5MB




Difusidon anisotrdpica

. . . lena-std-iter100
5/6 (iter80); 512x512 pixels; 8-bit; 1.5MB




Difusidon anisotrdpica

. . . lena-std-iter100
6/6 (iter100); 512x512 pixels; 8-bit; 1.5MB




Bordes sobre difusion isotropica y anisotropica

512x512 pixels; 8-hit; 256K

512x512 pixels; 8-hit; 256K

512x512 pixels; 8-hit; 256K
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S e Dot_Blot.jpg

513x282 pixels: 8-bit: 141K 513x282 pixels: 8-bit: 141K

®® @ Dot_Blot-iter20
513x282 pixels: 8-bit; 141K




Region Growing

* Plugins - Segmentation — Statistical Region Merging

- Se parte de que cada pixel es una regién y se van juntando regiones
vecinas mientras se cumpla un criterio de similitud entre regiones
vecinas. En este caso el nivel medio de gris. Parametro: niumero final
de regiones.

- Original, 25 regiones, 10 regiones, 5 regiones:

@ @® ® myelin.png @ @® @ myelin.png (SRM Q=25.0) @® @ @ myelin.png (SRM Q=10.0) ® @ @ myelin.png (SRM Q=5.0)
256x256 pixels; 8-bit; 64K 256x256 pixels; 32-bit; 256K 256x256 pixels; 32-bit; 256K 256x256 pixels; 32-bit; 256K




K-means

=) K-means Configuration

* Plugins - Segmentation - K-Means

Number of clusters 8

C | U Ste I'I n g Cluster center talerance 0.0001(
. . . , | Interpret stack as 3D
* Pa rt|C|Ona eI COnjuntO de plXEleS en k gru pOS .4 Enable randomization seed

Randomization seed 48

./ Show clusters as centroid value

- Cada pixel pertenece al grupo a cuya media
esta mas cerca.

4| Enable clustering animation
Print optimization trace
/| Send to results table

Help Cancel OK

® @ @ myelin.png @ ® @ Clustercentroid values @ ® @ Cluster centroid values
256x256 pixels; 8-bit; 64K 256x256 pixels; 8-bit; 64K 256x256 pixels; 8-bit; 64K
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Contornos Activos (Active Contours)

* Marcar una regién de origen, que se deformara hacia los bordes.
* Plugins -» Segmentation —» Level Set

- Dejar los parametros, salvo desmarcar fast marching y verificar que
crece hacia adentro.

° LOS pa ré m et rO S SO n d el i C a d OS . ;%3%2é§ T SGSI"":‘Eegmertation progress of Dot_Blot.jpg
. A
288 Dot_BElot.jrg . . . .
513x282 pixels; 8-bit; 141K
. s & & & & &
* o ¢ . e e & ¢

(m]
. . . . . . I Segmentation of Dot_Blot.jpg

513x282 pixels; 8-bit; 141K
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